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Tema: Imágenes multiespectrales de sensores remotos.  
 
Guía No 3. 
 
Objetivo: 
 
Realizar la clasificación digital no supervisada y supervisada de una imagen de satélite.  
 
Competencia interpretativa: El estudiante es capaz de poner en práctica los conceptos adquiridos durante la clase 
teórica y adquiere destreza en la clasificación digital de imágenes. 
 
Instrucciones 
 
a) Lea detenidamente toda la guía  
b) Verifique que cuenta con los elementos de hardware, software e insumos necesarios. 
c) Identifique y complete la información  que se le solicita 
d) Utilice el material como se lo indica el profesor. 
e) Al concluir el ejercicio participe en la socialización de las diferentes respuestas expuestas 
 
Recursos: Computadores de escritorio, Software ERDAS v11, imágenes de sensores remotos, respaldo bibliográfico 
sobre el espectro electromagnético.  

 
 

EJERCICIO 5. CLASIFICACIÖN DIGITAL 

 

La clasificación digital comprende el proceso de conversión de una imagen continua a otra categorizada 
temáticamente, a partir de agrupación de los niveles digitales  espectralmente similares. Existen dos métodos 
de clasificación: supervisado y no supervisado.  
 
5.1 CLASIFICACIÓN NO SUPERVISADA 
 
La clasificación no supervisada contempla los procedimientos de agrupación de los píxeles de una imagen 
según su similitud espectral, sin conocimiento previo del contexto temático. 
 
Clasificación Digital No Supervisada 
 
En este método no se requiere conocimiento de los tipos de cobertura a priori. El proceso se basa en la 
elección de las bandas espectrales de la imagen a clasificar, definición de numero de clases espectrales, 
selección de los criterios de similitud y algoritmos de agrupación de los ND (Posada, 2008). 
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En este método es el propio algoritmo quien define las clases de acuerdo a los datos. Para llevar esto a cabo 
es necesario suministrar algunos valores tales como el número de clases que se desea crear los tamaños 
mínimos y máximos de cada una, o ciertas tolerancias para la distinción entre clases. Estos parámetros 
(guían) al algoritmo en la definición de clases, que se produce en estos métodos de forma simultánea a la 
asignación de los elementos a una u otra de dichas clases. En general, se trata de procedimientos iterativos 
en los que una clasificación inicial va convergiendo hacia una final en la cual se cumplen las características 
buscadas de homogeneidad, número de clases, etc (Olaya, 2007). 
 
Los métodos de clasificación no supervisado entrega una capa raster con los píxeles clasificados, sin 
embargo no se tiene conocimiento acerca de las clases de cobertura suministrados por el algoritmo, y será 
necesario estudiarlas después para saber que representa cada una de ella. Si en un método de clasificación 
supervisada definimos zonas de entrenamiento con distintas clases de suelo, el resultado será una capa con 
clases de suelo. Si diferenciamos según otro criterio, será ese criterio el que quede reflejado en la capa 
resultante. En el caso de la clasificación no supervisada no existe tal criterio, ya que simplemente se aplican 
operaciones estadísticas con los datos, pero no se trabaja con el significado de los datos. Al utilizar una zona 
de entrenamiento sí estamos empleando este significado, ya que le estamos diciendo al algoritmo que los 
valores de dicha zona representan una clase dada, esto es, que “significan” dicha clase (Olaya, 2007). 
 
La elección de las bandas originales o sus derivadas depende del análisis estadístico de estas, por separado 
y en conjunto, en cuanto a su comportamiento espectral y separabilidad radiométrica. Por ejemplo, una 
imagen de LANDSAT_TM 5 cuenta con 7 bandas espectrales, de ellas estaría descartada la banda 6, por ser 
la banda de emisión de energía y no de reflexión. Las restantes bandas requieren de un análisis 
fundamentado, ya que al utilizar todas a la vez podría generarse la redundancia en información espectral, lo 
que afectaría los resultados finales. Con base en las experiencias prácticas se puede concluir que la 
utilización de 3 a 5 bandas, espectralmente contrastantes, es más que suficiente para una clasificación 
(Posada, 2008). 
 
El número de clases depende del análisis visual de la imagen, de los histogramas de las bandas y es un 
proceso de pruebas. Es bueno correr la clasificación con el mayor número y paulatinamente ir reduciendo su 
cantidad, volviendo repetir la clasificación hasta llegar a un resultado razonable. 
 
Junto a la capa de clases resultantes, los métodos de clasificación no supervisada proporcionan una 
definición de dichas clases a través de los valores estadísticos de las mismas. Estos valores se emplearán 
para asignar una interpretación a cada clase una vez éstas hayan sido definidas. Junto a ellas, es habitual 
añadir la varianza de cada clase, como indicador de la homogeneidad lograda en la clasificación (Olaya, 
2007). 
 
Aunque los métodos de clasificación no supervisada son válidos de por sí para establecer una separación 
categórica dentro de un área de estudio, es habitual que se empleen como soporte a métodos de clasificación 
supervisada. Mediante estos métodos se obtiene una primera división, que puede utilizarse posteriormente 
bien sea para la definición de zonas de entrenamiento o bien para operaciones más complejas como la 
segmentación de imágenes (Olaya, 2007). 
 
El resultado de la clasificación no-supervisada es categorización de la imagen en clases espectrales y usuario 
debe asignar el significado temático a estas, donde resida su mayor limitación. Así que, en general, este 



  

método nos es recomendable para producción de los mapas temáticas sino como paso previo la clasificación 
supervisada, la cual involucra conocimiento previo del área de estudio (Posada, 2008). 
 
El método no supervisado pretende a identificar las clases espectrales presentes en la imagen, 
proporcionando resultados a veces difíciles para interpretar y poco conectados con las necesidades del 
usuario final y no es claro como este puede identificar las agrupaciones naturales (Posada, 2008). 
 
OBJETIVO ESPECIFICO: Realizar una clasificación no supervisada de la  imagen LANDSAT TM. 
 
PROCEDIMIENTO:  
 
Desde la pestaña Raster, ir al grupo Classification, desplegar la opción Unsupervised y seleccionar 
Unsupervised classification. Se abrirá la ventana de Unsupervised Classification (ISODATA); bajo INPUT 
seleccione la imagen que va a clasificar y bajo OUTPUT CLUSTER LAYER,   entre el  nombre de la imagen 
de salida. 
Desactive la opción de OUTPUT SIGNATURE SET y confirme INITIALIZE FROM STADISTICS bajo 
CLUSTERING OPTIONS. Esto permitirá generar los clusters al azar. Entre el dato de 20 en el NUMBER OF 
CLASSES. 
 
Entre 10 como MAXIMUM ITERATIONS bajo PROCESSING OPTIONS. Este es el número máximo que 
ISODATA utilizará para reagrupar los píxeles de la imagen. Confirme 0.95 como CONVERGENCE 
THRESHOLD. Esto significa que al llegar al 95% de la agrupación de los datos sin presentar cambios durante 
las interacciones, el proceso finalizará. 
Oprima OK y espere a que se termine el proceso de clasificación. 

 
Figura 1 Menú de clasificación no supervisada 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



  

La segunda parte corresponde al proceso de evaluación de la clasificación, durante el cual se identifican 
y se asignan  los nombres de clases y los colores. Compare la imagen original con la imagen clasificada.  
 
Abra las dos imágenes (original y clasificada) en el mismo VIEWER, utilice la opción Swipe (Home, View, 
Swipe). Acceda a la pestaña Table, View, Show Attributes, allí se despliega la tabla de atributos en la 
parte inferior de la pantalla y se activan las opciones de la pestaña table, ahora vaya en esa misma 
pestaña a la opción Query y escoja Column Properties. 

 
Figura 2 Menú Column Propierties 

 
 
 
 
 
 
 
 
 
 
 
 
 

Desde COLUMN PROPERTIES,  bajo COLUMN,  seleccione OPACITY y oprima UP para mover 
OPACITY debajo de HISTOGRAM.  Seleccione CLASS_NAME y con UP mueva por debajo de COLOR. 
Asigne el número 10 en DISPLAY WIDHT. Oprima OK.  
 
Antes de iniciar el análisis de clases individualmente, se debe asignar el valor = 0 para todas las clases. 
En la Tabla de Atributos (ubicada en la zona inferior de la pantalla)  oprima la palabra OPACITY de la 
columna OPACITY, para seleccionar todas las clases y oprima el botón izquierdo del mouse, 
seleccionando FORMULA.... 

Figura 3 Menú Formula 

 
 

 
 
 
 
 
 
 
 
 
 
 
 



  

 
En la ventana de FORMULA, oprima 0 de la sección de números y APPLY para cambiar todos los 
valores en OPACITY a 0 y cierre la ventana con CLOSE.  
 
En la misma tabla, bajo columna COLOR oprima el botón derecho del mouse para cambiar el color 
de la CLASE 1,  por el color amarillo, después en la columna Opacity se le cambia el valor de 0 por 1.  
 
En el Viewer se desplegarán todas las áreas correspondientes a clase 1 con el color amarillo.  Desde 
la pestaña Home, ir al grupo View, allí desplegar la opción Swipe, seleccionar Flicker, en esa 
ventana oprima AUTO MODE.   Sobre la imagen,  la clase seleccionada comienza a aparecer y 
desaparecer. Analice a que clase temática corresponde esta área y asigne el nombre debajo de la 
columna CLASS_NAME en La Tabla de Atributos y cambie el color según el contenido temático de 
esta clase. 

Figura 4 Imagen clasificada con mascara de opacidad 

 

 
 

Cierre el FLICKER y asigne 0 en la columna de OPACITY para esta clase. Repita el mismo procedimiento 
para el resto de las clases. Al finalizar seleccione FILE / SAVE para salvar los cambios realizados. 
 
Para calcular el área correspondiente a cada clase, seleccione Table, Column, Add Class Name, (para esto 
es necesario que el raster este georreferenciado caso contrario la opcion Add column aparecerá desactiva), 
se despliega la ventana ADD AREA COLUMN dentro la cual seleccione HECTÁREAS como unidades de 
medida y asigne el nombre de columna y oprima OK. En  La tabla de Atributos se desplegará la columna 
correspondiente al área por cada clase. Analice el resultado y cierre la aplicación. 
 
 
 
 
 



  

Figura 5. Menú de adición de la columna de área 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5.2. CLASIFICACIÓN  SUPERVISADA 
 
La clasificación supervisada requiere de cierto conocimiento previo del terreno y de los tipos de coberturas, a 
través de una combinación de trabajo de campo, análisis de fotografías aéreas, mapas e informes técnicos y 
referencias profesionales y locales. Con base de este conocimiento se definen y se delimitan sobre la imagen las 
áreas de entrenamiento o pilotos. Las características espectrales de estas áreas son utilizadas para "entrenar" un 
algoritmo de clasificación, el cual calcula los parámetros estadísticos de cada banda para cada sitio piloto, para 
luego evaluar cada ND de la imagen, compararlo y asignarlo a una respectiva clase (ver Figura 10). La clasificación 
supervisada pretende definir las clases temáticas que no tengan claro significado espectral, considerada por esto 
como un método artificial (Posada, 2008). 
 

Figura 6. Esquema de Clasificación digital supervisada [Fuente: Olaya, 2007] 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 



  

 
 

El proceso de clasificación supervisada, se puede resumir en las siguientes etapas: análisis visual y estadístico de 
la imagen y de sus bandas, elaboración de la leyenda del mapa, selección y delimitación de áreas pilotos, 
generación y evaluación de sus estadísticas y reajustes, elección y aplicación del algoritmo de clasificación, 
reajustes y clasificación de nuevo, y finalmente, la evaluación de los resultados y su presentación (Posada, 2008). 

 
Análisis estadístico y visual de las bandas 
 
La etapa inicial consiste en valoración cualitativa y cuantitativa de la calidad de la imagen de modo multibanda, de 
sus contrastes, del comportamiento espectral de distintas cubiertas dentro las bandas espectrales y se evalúa la 
separabilidad espectral de las bandas en relación con estas. Al final se obtiene la primera apreciación sobre el 
número de posibles clases temáticas a discriminar, sobre las bandas a utilizar, y los posibles procesos adicionales 
para derivar las nuevas imágenes, que podrían ser útiles en la fase de clasificación (Posada, 2008). 
 
Algunas de las medidas o gráficas útiles para el análisis de las bandas son las estadísticas multibanda, correlación, 
varianza y covarianza, los gráficos de dispersión entre bandas, etc. 
 
Igualmente se seleccionan y se recortan las ventanas de trabajo, ya que es más operacional a realizar el 
procesamiento preliminar sobre las ventanas experimentales representativas y al final los procesos óptimos 
extrapolar sobre la totalidad de la escena (Posada, 2008). 
 
En general, el análisis se orienta a definir las cuales bandas de una imagen multiespectral se utilizaran en el 
proceso de clasificación. La idea se basa de elegir las bandas donde se presente mayor contraste espectral entre 
las coberturas – objeto del estudio. Intuitivamente pareciera que cuando se utiliza un mayor número de bandas en 
una clasificación, el resultado de la misma es mejor (Posada, 2008). 
 
Elaboración de la leyenda. 
 
Tomando en cuenta los objetivos del proyecto, el nivel de detalle requerido, la escala de trabajo y tipo de imagen a 
utilizar se revisan distintas sistemas de clasificación y se establece una leyenda especifica (Posada, 2008). 
 
Selección y delimitación de las áreas de entrenamiento. 
 
Es la fase más importante del proyecto. Requiere previo conocimiento de las características del área, así como de 
las categorías que pretende discriminar. Con base de experiencias locales y profesionales, trabajo de campo, uso 
de fotografías aéreas y otra información secundaria se definen y se delimitan las áreas de entrenamiento o pilotos 
representativas de cada una de las categorías de interés (Posada, 2008). 
 
Se basa en los criterios pictórico-morfológicos de la imagen, como: tono o color, textura, tamaño, forma, sitio, etc 
(ver Figura 7). La errónea selección de muestras conducirá a resultados erróneos. A partir de estas muestras el 
algoritmo clasificador calcula los ND que definen cada una de las clases y asigna el resto de los píxeles de la 
imagen a una de esas categorías. La delimitación se realiza mediante un ratón sobre la pantalla del computador. 
Se recomienda seleccionar varias muestras por categoría, para reflejar adecuadamente la variabilidad de la zona 
de estudio. Es importante contar con los datos de campo próximos a la fecha de adquisición de la imagen, con el 
fin de garantizar la consistencia entre la realidad y la imagen. Se recomienda evitar la delimitación de muestras en 
los sitios de transición entre las dos clases, ya que estas presentaran confusión espectral. Las áreas no deben ser 
muy homogéneas, obviando la variación real de las coberturas temáticas. El tamaño de la muestra, en teoría, 
puede ser de 9 píxeles.  



  

El número de píxeles recomendable es de 200 píxeles como mínimo, distribuidos sobre toda la imagen en varios 
campos pequeños y no en una muestra grande, para no subestimar la variabilidad de esa categoría. Debe tener en 
cuenta las propias características de la imagen intentando abarcar las variaciones que se presentan para cada 
clase, su orientación, pendiente, densidad, vigor, contenido de humedad y tipo del suelo (Posada, 2008).  

 
Figura 7. Selección y estadísticas de las áreas de entrenamiento 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Evaluación estadística de las áreas de entrenamiento 
 
Las estadísticas evalúan el grado de representatividad de las ares pilotos y dan idea sobre la separabilidad 
espectral de las clases temáticas, lo que al final garantiza una buena clasificación. Existen métodos gráficos y 
numéricos para evaluar las estadísticas, un ejemplo de estadísticas básicas se presenta en la Figura 7. 
 
Las más utilizadas son los diagramas de signaturas espectrales y los diagramas de dispersión espectral. Se basan 
en el análisis de las medias aritméticas y desviaciones estándar, la primera indica el comportamiento espectral 
medio de los ND, y la segunda el grado de heterogeneidad de la muestra. En un diagrama espectral se plasman 
las bandas que intervienen en clasificación en el eje X y las medias de ND de cada clase, con este gráfico se 
evalúan las tendencias espectrales de cada clase, resaltándose el compartimiento de las bandas espectrales en 
relación con sus vecinas. Las líneas paralelas y cercanas indican de posible confusión espectral y las 
intersecciones ente las líneas, la buena separabilidad entre estos (Posada, 2008). 

 
 
 
 



  

 
Figura 8: Gráficas de dispersión de áreas de entrenamiento en las bandas TM3, TM4 y TM5 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
Elección y aplicación del algoritmo de clasificación 
 
Con base de las áreas de entrenamiento delimitadas se puede iniciar el proceso de clasificación el cual es 
automático. El proceso consiste en agrupación de todos los píxeles de cada banda espectral a uno de las clases 
predeterminadas en la etapa anterior. El resultado será una nueva imagen donde los ND están categorizados en 
clases temáticas, y la cual se considera como un mapa digital formato raster. Pero antes de correr la clasificación 
se requiere elegir el criterio o algoritmo de asignación. Los más comunes son de Mínima Distancia, de 
Paralelepípedos, y de la Máxima Probabilidad o Verosimilitud (Posada, 2008). 

 
OBJETIVO ESPECIFICO: Realizar clasificación supervisada de la ventana de la  imagen  LANDSAT TM. 
 
PROCEDIMIENTO:  
 
RECOLECCIÓN DE ÁREAS DE ENTRENAMIENTO Y GENERACIÓN DE SIGNATURAS 
 
Despliegue la imagen que se va a clasificar en una composición a color apropiada y aplique los 
mejoramientos necesarios para disponer de una vista óptima para  la identificación y delimitación de los 
patrones o áreas de entrenamiento. 
Analice el paisaje presente en la escena, identifique los principales tipos de coberturas presentes en la 
escena y elabore una leyenda que contenga las clases temáticas deseadas. 
Desde el menú principal de ERDAS vaya a la pestaña Raster / Classification / Supervised / Signature 
Editor 
 
Para iniciar, diríjase a Drawing, insert geometry (allí se encuentran las herramientas necesarias para la 
elaboración de las áreas de entrenamiento)  
 

 
 



  

 
Figura 9: menú de Drawing 

 
 

 
 
 
 
 
Analice la escena de la imagen y utilizando la opción de ZOOM del VIEWER haga un acercamiento a la 
parte de la imagen donde va a colectar la primera área de entrenamiento, p.e, agua. Active el icono de 

POLYGON   y delimite el área de interés. Con el doble clic  finalice la delimitación del polígono, el 
cual debe ser bordeado por una caja, indicando que este está seleccionado. 

En la ventana de SIGNATURE EDITOR oprima el icono  de adición de signaturas. Bajo la columna 
SIGNATURE NAME aparecerá consignada esta primera signatura con el nombre de CLASS 1. Oprima el 
botón izquierdo del mouse y cambie el nombre por uno que represente la clase de cobertura 
seleccionada.  Bajo la columna de COLOR, oprima el botón izquierdo y asigne el color apropiado para 
esta clase temática. Proceda con la generación de áreas de entrenamiento y sus signaturas  espectrales 
para otras clases de la leyenda.  
 

Figura 10: Menú de asignación de clases del Signature editor 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Recuerde, que áreas de entrenamiento deben representar la variabilidad espectral de la cobertura estudiada: 
sin ser muy homogéneos, ni muy heterogéneos; el tamaño de muestra debe ser como mínimo 10 veces más 
grande que el número de las bandas; si la cobertura presenta variación espectral, se generan varias áreas de 



  

entrenamiento y para cada una se calcula la signatura espectral  posteriormente los unen en una solo clase, 
p.e agua1, agua2, agua3 se unirá en clase de agua. 
 
Para el área urbana, muy heterogénea como un conjunto,  determine el area mediante uso de la herramienta 
SEED GROWING. Para esto, vaya a la pestaña Drawing, Insert geometry, despliegue Grow y seleccione 

Growing Properties. Se abrirá la ventana de REGION GROWING PROPERTIES.  Oprima el icono  y 
bajo GEOGRAPHIC CONSTRAINTS active la opción AREA y entre el valor 500 píxeles, máximo número de 
píxeles para incluir en el AOI. Bajo SPECTRAL EUCLIDEAN DISTANCE entre el valor 10.00. Bajo 
OPTIONS... asegúrese que esta activada la opción de INCLUDE ISLAND POLYGONS. Cierre la ventana. 
 

Figura 11: Menú de captura de semillas ingresar áreas de entrenamiento 

 

 
 

Haga clic sobre la imagen, bajo el área de interés y genere el polígono, En la ventana de REGION 
GROWING PROPERTIES cambie los valores de área y distancia (p.e. 1000 y 20) y oprima la opción  
REDO. Observe el resultado.  Explore la opción  Option y consulte Help para ver el significado de los 
parámetros de estas opciones. Después de la creación de AOI, adiciónelo en la ventana de SIGNATURE 
EDITOR y asigne un  color apropiado. 
 

Figura 12: Capa de AOI con información capturada para área de entrenamiento 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 



  

 
Según sus criterios, utilice uno u otro método de recolección de áreas de entrenamiento para todas las 
clases temáticas. 
No olvides salvar las áreas de entrenamiento desde el Viewer con opción de File> Save>AOI layer as...;  
y las signaturas desde la ventana  Signature Editor. 

 
 

EVALUACIÓN DE LAS SIGNATURAS CREADAS 
 

Una vez creadas las signaturas, se pueden borrar, renombrarlas o fusionarlas;  pero antes se  
debe     realizar  su  evaluación  mediante  análisis Matriz de contingencia, separabilidad de  
signaturas, Estadísticas e histogramas y curvas espectrales. 

 
Para iniciar la evaluación estadística, dentro   Signature  Editor   seleccione  la   opción   File- 
Report, (Calcula estadísticas básicas: mínimos, máximos,  media  y  desviación   estándar  de  las 
áreas de entrenamiento para cada banda).  Señale Statistics y All Signatures. Analice  si  algunas  
signaturas se superponen estadísticamente, observe  los  valores  de  las  desviaciones  estándar  y  
rango  mínimo y máximo para cada clase. 

 
Figura 13: Menú de reporte de información estadística de las áreas de entrenamiento  

 

   
 

Análisis de histogramas: Dentro de la ventana Signature Editor utilice la opción , para calcular y 
analizar los histogramas para cada área de entrenamiento en cada banda espectral. Los histogramas 
deben tener forma próxima a campana (Distribución normal), ser unimodal y tener los rangos de mínimo y 
máximo razonables para no traslaparse con las signaturas de otras clases. 

 



  

Curvas espectrales: Seleccione la opción View -  Mean Plots- Multiple Signature u oprima el botón 

. Se abrirá la ventana de Signature Mean Plot, en la cual se observan las curvas espectrales de las 
áreas de entrenamiento. Analice en que bandas y que clases presentan traslapes y confusión espectral y 
deben ser cambiadas o reajustadas o unidas en una sola clase. 
 

Figura 14: Gráficas de curvas espectrales de áreas de entrenamiento 

 

 
 
 

Separabilidad espectral: Seleccione la opción Evaluate – Separabilility,. Aparecerá la ventana de 
Signature Separability. Seleccione las opciones de Distance Measure  - Trasformed Divergence y 
Complete report. Practique diferentes opciones frente a Layers Per Combination, para ver con que 
combinación de bandas se presenta mayor separabilidad entre signaturas espectrales.  Mediante este 
procedimiento concluya con que combinación de bandas se presenta mayor separabilidad espectral y 
que clases presentan baja separabilidad. (El valor mayor a 1950 – corresponde a excelente 
separabilidad, separabilidad media- entre 1950 y 1900; y baja separabilidad    corresponde a valores 
menores a 1900.) 
 
 
 
 
 
 
 
 
 
 
 



  

Figura 15: Menú de evaluación de la separabilidad espectral 
 
 

   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Uso de la matriz de contingencia: Calcule la matriz de porcentaje de píxeles que se incluyen dentro el 
área de entrenamiento. Para este fin, seleccione desde la barra del menú de SIGNATURE EDITOR la 
opción EVALUATE / CONTINGENCY..., se abrirá  la ventana de CONTINGENCY MATRIX. Defina los 
parámetros de las reglas de las decisiones según la ventana de dialogo  presentada abajo. Oprima OK  y 
espere que termine el proceso y  analice los resultados.    
 

Figura 16: Matriz de contingencia 
 

    
 
 



  

 
AJUSTES  
   
Corresponden a acciones de borrar completamente una signatura, unir con otra signatura o recalcular la 
signatura a partir de redefinición de área de entrenamiento. 
 
Para borrar: seleccione la signatura en columna Class, esta se iluminara con el color azul y con el boton 
derecho oprimido oprime la opción Delete Selection. 
 
Para unir: con el uso de mouse y oprimiendo Shift de teclado, seleccione dos signaturas que se piensa a 

unir, p.e agua 1 y agua2; y luego, oprime el botón  (Merge selected signature). Al final de filas 
aparecerá nueva signatura, resultado de la unión (Class1). Las dos seleccionados siguen realzadas; con 
el botón izquierdo del mouse borra estas signaturas y a la asignatura de unión asigne el color de nuevo y 
un nombre, p.e.: agua. 
 

Figura 17: Tabla de Leyenda a partir de las áreas de entrenamiento colectadas en edición 
 

 
 

Para reemplazar una signatura o modificar: primero, en el Viewer ubica y seleccione su área delimitada, 

oprima el botón   Reshape, ubicado la pestaña Drawing, Modify, despliegue line, , en ventana de 

Signature Editor  seleccione la signatura iluminando con el color azul y oprime el botón   (Replace 
Current Signature).  
 
Al terminar ajustes, organice la signaturas en la tabla, ya que al unir las diferentes signaturas se alteró su 
orden; observa las columnas VALUE y ORDER. Para esto utilice la opción Edit>Values>Reset y luego 
Edit>Order>Reset. 

Figura 18: Herramienta de reset para editar la tabla de categorías 
 

 



  

 
Finalmente, salve las áreas de entrenamiento desde el File y signaturas desde Signature Editor, con 
nuevos nombres, para no dañar los primeros archivos. Evaluar de nuevo estas signaturas y si está 
satisfecho, proceda con el siguiente paso: agrupación.  
 
AGRUPACIÓN ESPECTRAL  
 
La etapa final de la clasificación corresponde a la agrupación de los ND de toda la imagen alrededor de 
las clases temáticas definidas en el proceso de patronamiento, mediante unos algoritmos específicos de 
agrupación, que pueden ser: Mínima Distancia, Mahalonobis Distancia y Máxima Verosimilitud. El mejor 
resultado de la agrupación ha demostrado ser el algoritmo de Máxima Verosimilitud. 
 
Para realizar la clasificación, desde la ventana Signature Editor seleccione Edit – Layer Selection. Elija 
las bandas que presentaron mayor separabilidad, durante el proceso de evaluación de signaturas 
espectrales.  Cierre la ventana de dialogo de Layer Selection. 
 
En la ventana Signature Editor oprima Classify – Supervised.   Aparecerá la ventana de Supervised 
Clasification;  Asigne los parámetros de clasificación según se indica en la figura de abajo; escriba el 
nombre de salida del archivo  para la imagen clasificada y clic en OK.  
 

Figura 19: Menú de generación de la imagen clasificada resultado del proceso 
 

 
 

Abra la imagen original con una combinación de bandas apropiada y sobre esta superponga la 
imagen clasificada. Utilizando la opción del SWIPE realice el análisis de correspondencia 
temática. También se puede proceder con el análisis utilizando los procedimientos realizados 
durante la clasificación no supervisada. 

 
 



  

Figura 20: Vista de la imagen resultado de la clasificación digital 
 

  


